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2.Ava@opa kat xp1)o1) BACIK®WV EpYaAeiwV oxeSlaong

2.1. H maAéta epyaieiov

[Tept oXESLACTIKWV TIPOYPAUUATWY

Jta oXeSLAOTIKA POYPAUOTO, CUVETIWC Kal oto Flash, umtdpyel pia epyalelodnkn pe
epyoheia oxediaong kabe £va amo Ta onola ekTeAEL Lol CUYKEKPLUEVN EVEPYELA. Ma va
oXe6LACOUE OTLONTIOTE,

e  KAVOUUE KALK OTO £pYOAELo,
®  OTNV CUVEXELX KAVOUE KALK 0TOV KauPa oxedloong kot
e o£pvoupe oxedlalovtag To avaAloyo oxfiua.

ErumAéov untdpyxouv TAAETEC EpYAAEiWVY LLE CUYKEKPLUEVECG AELTOUPYLEC TTAPAETPOTIOLNGNG
KOLL TPOTTIOTIOINONG TWV OXNUATWY TIOU GTLAXVOULE.



Mo va Staléete
éva epyalelo,
KAVTE KALK TTAVW
Tou.

Mropelte va
XPNOLLOTIOL|OETE
TO MARKTPO
GUVTOUEUONG TO
onoio
eudaviletal o
napevOeon wg
tooltip eav
adnroete Tov
Selktn Tou
TIOVTLKLOU TIAVW
ard to gpyaleio
ylot LEPLKA
Seutepodemra.
Avadloya pe to
ETUAEYHEVO
epyaleio o
Selktng TOUL
TIOVTIKLOU TtalpVEL
To avdloyo
oxfua.

Mepika epyadeia
elvat
opodomnolnuéva
ava Asttoupylia.
AuTo daivetal
armo eva
€lKovidLo oto
KAatw-8e€l pépog
Tou epyaleiou.
3TNV MepLoxn
ETAOY WV,
spdavidovral
ETUAOYEC
TIOPAETPOTIOING
ng tou
£TIAEYUEVOU
epyoAeiou.

H raAéta epyaleiwv (Etkova 13) epléxel epyaleia oxedlaong, emhoyng Kat mAonynong. Eav n
naAéta epyaleiwv Sev elval opartr|, pnopeite va tnv epdavicste emidéyovrag Window>Tools.

Ewoéva 13
Selection (V)— @ Rt Free Transform Tool (Q)
% :i Gradient Transform Tool (F)
Epyasia Subselection (A)—
EmAoyAc &I‘ 0 3D Rotation Tool (W)
Q A 3D Translation Tool (G)
Lasso (L)— & Q Pen Tool (P)
\b‘ Q" Add Anchor Point Tool (=)
Text(T)— T Q‘ Delete Anchor Point Tool (=)
Epyahsia Line (L)— \ N Convert Anchor Point Toal {C)
Zyebiaong
kal Keipévou L, —= [ Rectangle Tool (R)
Pencil (Y)— ./~ () Oval Tool (0)
./‘ [&l Rrectanale Primitive Tool (R)
Deco (U)— &7 2 Oval Primitive Tool (0)
J O PolyStar Tool
Epyaheia &‘ 4 Brush Tool (B)

Peruoapioparog

Epyahctia
MAorynang

Nepioyr| xpwparwy

Meproyr) emAoywy

Eyedropper (I)— #
Eraser (E)— &7

Hand (H)— &4
Zoom (Z)— &
Xpwpa 7
Mepiypapparog—[ |
Xpwpa %

repioparoc— [l
Malpo & Aeukd— my
Evalhayr| xpwparwy — =%

w@ Spray Brush Tool (B)
Hf Bone Tool (X)

(7 Bind Tool (2)

& Paint Bucket Tool (K)
@» Ink Bottle Tool (S}




2.2. Selection Tool

Selection tool (uaUpo B£Aog): MeTaKIvel, ETIAEYEL KoL TTApapopPWVEL Eva oxiua. Mrmopel va

eMAeyel matwvTag Kot To MARKTPOo V Tou TTAnKTpoAoyiou.

Color tools (Epyaieia Xpwpatog)

‘Eva oxua amoteAeltal ano SUo XpwUaTa, TO ePlypappa KAl TO YEULoUA (Elkova 14). To

XPWUOL ETUAEYETOL OO £VA XPWHATLOTO KOUTL TO OTOL0 avolyEeL Lol TTOAETO XPWHATWV.

Yriapyxouv ta Ot €€ ¢ TUTOL XPWHATWV:

e Stroke Color: PuBuilel To Xpwa TOU TIEPLYPAUUATOC.

e  Fill Color: PuBuileL To xpwpa TOU yepiopatog.

TNV MOAETA XPWHATWY
ETUAEYOUE T
akoAouBa:
o Xpwua
o Awadavela
e Anoucia
XPWHOTOG
e [leplocotepa
Xpwuota
Meptooodtepa ya o
XPWUAT OTNV EVOTNTA
‘3. Atayeiplon ypwudtwv
oto Flash’

Ewova 14
Tpixwv  Kwdixog Mooootd n:pooabnpd
ouqq Am €1ag x
2 a& Alpha:s :\.21 j
B —nepiypappa
& r
BB ranopa I

EBEE

)




Emidoyn oxfuatog

répopa Nepiypappa (pEpvw Tov SEIKTN TIEPLUETPLIKA
AnAG KALK: ETiAéyEL TO YEULOUO TOU OXNUATOC)

AuTAOS KALK: ETiAEyeL yépLopa & Tieplypappa. | AAS KALK: ETUAEYEL Eval KOUUATL TOU
TEPLYPAUMOTOC aVAAOYQ LUE TO OXNHAL.
AutAS kKAK: ETtiAéyel OAo To Ttepiypappa.

Ewova 148
Mn emAeypévo  THuopa Fepopa kol ‘Eva pépog OAGxAnpo

oxnua TEPIYPAPPA  TOU TTEPIYPAPPATOS  TTEPIYPAppQ

Me emiheyuévo €va oxnua Kol LECw Tou properties inspector propoUpe va petaBalovpue
T Slaotdoelg (width & height), tnv 8£on (x, y) He 1 xwpic KAEWOWUEVEG TIG avaloyieg, To
TLAXOG TOU Meplypappatog (stroke & height), tov tUmo tou meplypduparoc (style) kot tov
TPOTO gUPAVIONC TWV YWVLWV oTo oxnua (cap & join).

Opadomoinon oxnUATWY

MrmnopoUpe va eTAEEOUE VO ETUAEEOU UE TIEPLOCOTEPA ATIO £VA OXALOTA KPOTWVTOG
natnuévo to ANKTpo Shift kot otnv cuvéyela va ta opadomnoljcoupe oto pevou Modify >
Group. Otav opadomnoinBolv ta avilkelpeva cupnepldpépovtal oav éva. OpadomoLwvTog
OVTIKE(PEVa, pmopoUpe EUKOAQ VA TOL LETAKLVI|COULE.

MropoUpe va emavad£pou e £Vo OpOSOTIOLNUEVO GO OTA ETTL LEPOUC OXNUOTAL:

o  Kavw 6e€i-kALlk oTO opadomolnpévo oxfpa Kot ord to avadudpevo HeVoU eTIAEYW
break-apart

e Ao to pevol Modify emidéyw Break apart j Ungroup

e [atdw tov ouvduaopod mAnktpwv Ctrl+B.

o  Kavoupe Sei-kALk 0TO OLASOTIOLNUEVO AVTIKELEVO KOL OO TO UEVOU ETUAEYOUUE
Break apart.



Emidoyn kat aAdayn evog HEPOUG TOU OY1ULATOG

MTtopoU e Vo KAVOUUE KALK OTOV KOUBA Kal va CUPOUUE ETAVW OF Eval oA
SNULOUPYOVTAG LE TOV TPOTIO QUTOV €va apdBupo eMAOYAG. 2TNV CUVEXELD, AANGTOUE Ta
xpwuota péoo amnd to properties inspector (ewéva 14y). To anotéAsopa Oa sivat va
oAAoyBoUV Ta XpWHATO TOU EMIAEYUEVOU OXAUATOC. MTtopw va KAVw KALK Kal va cUpw To
ETUAEYUEVO OXAMA. ITNV CUVEXELD QTTOETIAEYW TO OXAA KAVOVTOG KALK 0TO OKNVIKO.

Ewova 14y
MapGBupo EmiAeypévo AAMAayn Merakivi) To oxfpa  KGvovrag KAk oTo
" emhoviig KOppGTI XPwhaTwy o€ GAAo onpeio OKNVIKO aTrosTAfY W)
TO OXfjpa

R [
N md i BN

AN aen oynuatog

Evépyela

Epdavion

AnotéAeopa

O 8elkTng TOU MOVTIKLOU O€
aKpR

Eduaviletal éva avamnodo
L k&tw oo tov Seiktn

KALK KalL 0€pVW TNV KA

O 8elkTng TOU MOVTIKLOU O€
guBeia | KOUIUAN

Edpaviletal éva
NULKUKALO KATW OO ToV
Seiktn

KALK KL KOUTTUAWVW TNV
euBeia N o€pvw TNV KOUTTUAN.

Ewova 146

[ ®Zpvw TOV BEIKTN
oV ywvia

Dépvw Tov deiktn
oy mAsupd

Kavw KAk kai oépv

-
—

Kavw KAk kat ofpvw

- B -




EmucaAvym oxnuatwv

YxebLaloupe €vav KUKAO TAvw o€ £va Tetpdywvo (1). Otav petakivriooupe tov KUKAO, To
KOMATL TTOU KAAUTITE 0TO TETpAywvo s€adavilstal (2).

Ewova 14¢
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2.3. Sub selection tool

(white arrow): ETIA€yEL KOl LETOKLVEL TA ONLELO EVOG OVTIKELUEVOU.
KaumnuAwvel Ta povomnartia (paths) petaft yettovikwy onpeiwv.

Brjpota Ewkova 15

1. EmAéyoupe to 1 X
epyaleio sub
selection tool.

2. Kavoupe kALK oTto 2
neplypappo Tou
OXNMOTOG.

3. Em\éyw éva onpeio,
TO 0€pVW Kal adnvw

TO TOVTiKL.
4. Me KpaTnuUéVo TO —
TAnKtpo Alt, Kdvw

[

KAik otoonueio onote
KOLL T(POKOAW

KOUTUAWON TWV .
TUNUATWY

EKATEPWOEV TOU ’ .
onueiou. X
EpdaviZovrat ot - ,

AaBég kapmUuAwong.
5. Me noatnuévo 1o

TANKTpo Alt, Kavw 5

KAWK o€ pa Aafn kot

TV oépvw, O

aveédptnta amno tnv

AGAAN Aafn.

B

Znueiwon 1 - Oépvwvtag
To TovTiKL KoVTd o€ éva
onueio epdaviletal éva
TeTpdywvo Sirmha amnod tov
SEelKTN TOU TIOVTIKLOU:

e Av eival domnpo
UETAKLVOULLE TO
onueio.

e Av eival pavpo
METAKLIVOUE OAO
To oX£blo.

Inueiwon 2 —'Exovtag
TATNUEVO TO TTARKTPO
Shift pmopoupe va
KAVOUUE KALK o€ TIOANG
onueia ta omoia otnv
CUVEXELO LETOKLVOUE
elte pe 1o movrtiki gite pe
ta B€An Tou



TAnKTpoAoyiou.



2.4. Free transform tool

Meplotpédel éva emleypévo avtikeipevo katl aAAalel To péyeBog Tou.

Otav emiNé€oupe éva oxnua pe to transform tool (swkdva 16),

Ewkova 16
IAAA QYT AMayn
HeyEBoug Kal Aapf IJE_VL'SOUC,‘MM
TTEPIOTPOQT) ahAayrc TEPIOTPOQT
pcvfeoug
Ao Aot
akhayrg akhayrig
HeyEBoug : . peyEBoug
g e AMayf
/ ’ \\ ~~ peyEBoug ka
AMayr Aapn . KE.‘_ma”EDlUIpO&ﬂ
pEyEBOUG Kal aAhayrig TapapdpQuONC,
TEPIOTPOYT pevEBoug MEPIOTPOYNC

e To oxnua emAEyeTal.

o [leplUETPLKA TOU oxAuatog eppavilouvtal ot AaBég ahhayng peyéboug kot
TepLoTpoPnG.

®  3TO KEVTPO TOU OXNMOTOG éudavileTal £vag AoTpog KUKAOG yUpw artd Tov omolov To
oxnua neplotpédetal Kal mapapopdwvetal. Tov KUKAO aUTOV UIMOPOUE VO TOV
ETUAEEOU E KOLL VO TOV CUPOUE 0 AAAO ONUELD EVIWCE KAl EKTOG TOU OXIHATOC.

e [0 vo mePLOTPEYPOUHE TO OXHUA, GEPVOULE TOV SEIKTN TOU TTOVTLIKLOU OXL TIOAU
KOVTA OTLG YWVLAKEG AaBEG Kol OTav epuavioTel Eva elkovidlo neplotpodrg TOTe 1O
O£PVOUUE TIEPLOTPEDOVTAC TO OO YUPW OTtd TOV AoTIpo KUKAO.

e o vo aANGEOUpE TO nEYEDOG O0TO oXUa, EPVOULE TOV SELKTN TOU TOVTIKLOU
KOVTA oTi§ AaBEG, YWVLOKEG KO LN, KAl 6tav doUpe éva SUMAO BEAOG TOTE KAVOUUE
KALK KOl GEPVOUE. Mo TIAPAPOPPWOOULE TO XA LE SLOTNPNUEVEC TIG AVOAOYLEG,
CE£PVOUE TIC YWVLAKEG AaBEC £xovToc Kpatnpévo Tto ANKTpo shift.

e Lo va napopopdwWooUHE To oXNUA, GEPVOULE TOV SEIKTN TOU TTOVTLKIOU OVAMECTL
oG AaBEC, OTIG YPAUUEC Kal OTav yivel SMAG opaAAnAo BEAOG, KAVOUE KALK KoL
O£PVOUE.

Inpeiwon: Oplopéveg amo TIg eTAOYEG Tou epyaleiou uTtdpyouV Kal oto pevol Modify >
Transform

10



H maléta Transform

Avolyel amno to pevoy Window > Transform

Me tnv noAéta
Transform, pmopoUue va
KAVOUUE
TPOTIOTIOL|COUE TO
OXNUO OTIWC KL LLE TO
TovTikL aA\a divovtag
OUYKEKPLUEVEG TLUEG.
ErtutAéov, pmopol e va
epapudoovpe pa
mapapopdwaon os Eva
avtiypado tou
ETUAEYUEVOU OXALATOC
OTIWG KOl VA TNV
OVOLPECOUIE.

Aiarfipion

Ewova 168
Ahhayr| T T = e
pEyEBOUC 1000% $ 1000% )
NepioTpogri—+—&) Rotate
4 00°
Napapdpeuwon—E) Skew
3D Rotation
X: 00° Y- 0Q° Z: 0po
3D Center point
X 0.0 Y: 0.8 Z: 08

QVaAOyIWWW

| _Avaipean

AvTiypa@r) £mAoYrg
KQI TTApapop@won

TapapopYWONg

[Teploxn emAoywv otV TAAETA Epyaieiwv

Otav éxoupe emilé€el To epyaleio Free transform, otnv meploxn emAOYwvY TNG MAALTAG

epyoheiwv BAEMOUE TIC aKOAOUOEC eMIAOYEG:

1 Snap to objects: To emheypévo avtikeipevo eAkUETAL OO GAAQ

QVTLKE(HEVOL.

2 Rotate and skew: H napopdpdwon neplopiletal otnv
TEPLOTPOdH] KaL 0TO OKEPPWON TOU AVTLKELEVOU.
3 Scale: H mapapdpdwaon neplopiletal povo otnv aAlayn

pey£bouc.

4 Distort: EAeUBepn mopapdpdwon.

11
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2.5. Lasso tool

Lasso tool (ewkdva 20): Kavoupe KALK KoL OEPVOUUE €va OKAVOVLOTO TAALCLO ETIAOYNC,
ouvnBwg KAELOTO, Ot La TtepLoyn).

Otav adrooupe Tov S(KTN TOU TOVTIKLOU £XEL ETILAEYEL N TIEPLOXH TIOU OploalLE.

JTNV CUVEXELQ, UTTIOPOULE VO KAVOUE TNV Omola oAAayr BEAOUUE GTO OXHLO KOL TO XPWHUO
NG ETUAEYUEVNG TTEPLOXAG.

Otav emAé€ou e TNV TIEPLOXN KOL TOTOBETACOUE EMAVW ATO AUTAV TOV SEIKTN TOU
TIOVTIKLOU, Ba S0V E TMWC LETATPEMETAL OE OTAUPWTO BEAOG OTIOTE KAl UTTOPOULE VOl
UETAKLVCOULE TO ETUAEYUEVO KOUUATL.

Ewova 20

EAe0Bepr emAoyr
repIoynig

12



2.6. Pen tool

Yxeblalel euBeleg ) KAUTTUAEC ypaUUEG. MTopeite vor SNULOUPYNOETE Kal KAUTIUAEG Bezier.
Kavoupe kALk oto gpyaleio i og dAAo epyaleio armd To UTO PevoUl Kal:

Pen Tool (sikova 21a)

e Kavoupe KAk oto 1o onueio.

(ewkova 21a)

e Kdvoupe SLokoXKA KALK SLapoppwvovtag To 1o
£T0L TO oYM TTOU EMIBUMOUE. gnueo
e 3TO onuelo To omoio BEAwW va epdaviotouy  [TeAsuraic——)
KOUITOAEG, KAVOUHLE KALK KOl GEPVOULE. KAIK 010 ' Aiadoyika
Epdavilovral tote AaBéG KapmUuAwong To onpelo kA
EKATEPWOEV TOU onpeiou. Asv umopw va ~—
XELPLOTW TLG AaBEC e TO epyaleio auTo. \
e L0 va KAelogl To OXNUO, KAVOUUE KALK OTO KAk kai
1o onpeio. otpvu'y e
. , . KQUTTUAN
®  >TNV ouveXELa YEUL(OUE TO oYU LE TO
epyaleio Paint Bucket.
Add Anchor Point (ewkdva 21)
‘Exovtag emilé€el to epyaleio Add Anchor Point o dsiktng yivetal gwova 218
pLa éva He éva cUPPBoAo ‘4. Kavw KALK 0TO TiEpiypapa TOU A

OXNUOTOG KaL:

e Av KAvoUE KALK o€ €va ohpelo oto meplypappa (onueio A),

TpootiBetal £va onpeio.

e  Av KAvVOUE KALK O€ €va onuelo oTo Meplypappa Kot
oUPOUHE, TTpooTiBeTOL £VOl ONUELD UE KOUTTUAES
£KATEPWOEV TOU onueiou evw gpdavilovrol ot AaBEg
KOUMUAWONG. AgV UTIOPW VOL XELPLOTW TLG AaBEG Ue To

gpyaleio auTo.

e Eadv nmatrow to mAnktpo Alt tou AnktpoAoyiou, To cUUPBOAO
‘+' LETATPEMETAL O€ ‘-’ OTOTE KO UMOPW VA apaLpEcwW

onueio.

Delete Anchor Point (etkdva 21y)

‘Exovtog emiAé€el To epyaleio Delete Anchor Point o
Selktng ylvetal pua méva pe éva oUPBoAo ‘-’ Kavw kALK
OTO MePlypapa TOU OXNMOTOG KaL:

e Av KAVOUE KALK Og €va onpelo oTo Tepiypoppa

(onueio A), to onueio adatpeital.
e Eav éva onpeio éxel kapmuAeg ekotépwOev, ot
KopumUAEG Staypddovtal.

€lKOvVa 21y

e Eav nmatow to mAnktpo Alt tou mAnktpoloyiou,

TO OUMPBOAO ‘- LETATPETETAL O€ ‘+’ OMOTE Kol
UTopw va pocBEcw onpeio.

13




Convert Anchor Point (etk6va 218)

‘Exovrag emilééel To epyadeio Convert Anchor
Point o Seiktng yivetat £éva koppévo BENOC.
Kavw kALK 0TO TEPlypOLLO TOU OXHUOTOG KOLL:

Av KAvoulEe KALK Og €va ohelo oTo
neplypappo (onueio A), to onpeio
adatpeital pall pe TG KoUUmUAES Tou
UTIAPYOUV EKATEPWOEV Ao auTo.

Av Kavoupe KAk o€ €va onueio (B) kat
ocUpoue, epdavitovral oL AaPég
KOUMUAWONG TLC OTIOLEG O£PVW KoL
adrvw omou BéAw. Eav undapyouv
nén, Ba dnuoupynBolv amo tnv
apxn.

MmnopoUpe va riidcoupe pa Aapn ()
KOlL VO TNV cUPOUUE O€ GANO onuElo
peTaBAaAlovtag €ToL TNV KAUTUAN.

Inpueiwon: pe to epyaleio Convert Anchor
Point 6&v umopoU e va LETOKIVAGOUE
onueta. Metakwolpe povo Aafég. Eav
B£AoupEe va LETAKIVAOOUE OnUEla, TIPETEL VA
Xpnolpomnotiooupe To epyaleio Sub selection.

14
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2.7. Text Tool

Mo thv dnuioupyia KELPLEVOU UMOPEITE Vo XPNOLUOTIOLROETE TO epyaleio Text i va avilypaete Kat va

ETUKOAANOETE KElEVO Ao AAEG TNYEG. META TNV dnpoupyia KELULEVOU, UMOPELTE Vo

XPNOLLOTIOLOETE TOV EMIOeWPNTH LELOTATWY yLa va aAAGEETE TIG LBLOTNTEC TOU.

Yridpxouv 3 TUTIOL KELLEVOU TOUG OTtoiloug opilete otov emBewpnTh LOLOTATWV.

Static. O €’ oplopou tUnog eivat o static. O TUmog Static xpnolpomoteitatl yla Kelpevo to

omoio 6ev LETOBAAAETAL OTIWG ELVOL AUTO OTO KOUMTILA KOLL OTLG ETIKETEG.

Dynamic.O tumnog Dynamic, xpnoLomoleital yia kelpevo to onoio Ba tpomomnotnBel amno tov

XpNotn Onwg eival ta anoteAéopata ano pa Baon 6eSopévwy.

elval To dvopa XprRoTn Kot 0 KwSLKOG.

Anpovpyla Ketpévou

Input. O TUTOG Input XxpnoLpomoLeitat yla tTnv cuAAoyn TANpodOopLWY ATIO TOV XPHOTH OTIWG

10.

Zekwnote 1o Flash

Avoifte éva véo £yypado.

TNV epyalelodrkn, eTuAe€Te To epyaleio
Text (Ewkova 22a).

MeTtakLvriote Tov SelkTn TOU oVTLKLOU OTO
OKNVLKO.

O beiktng aAAalel o€ oTaUPO pall e TO
ypaupa ‘T,

Mo va dnpoupynoste €va mebio Kelpévou
HE METABANTO UNKOG, KAVTE KALK OTO
OKNVLKO.

To nebio kelpévou mepthapPfavel Eva
onueio eloaywyng, insertion point, to
omolo avaBocfrvel. ITo onueio auto Ba
davel 1o keipevo mou Ba ypayete. H
KUKALkr Aafn, round handle, 5eiyvel o0tL T0
KELUEVO EMEKTEIVETAL OE LA VPPN
(Ewkova 22b).

Mpayte to Keipevo.

To neblo KeLPEVOU eKTElvETOL 000 YpADETE.
Kavte KAK pakpLd armd To KELMEVO yLa va TO
omoeTAEEETE.

Mo va dnuoupynoete kelpievo otabepoul
UrKOUG, oUpPETE Mepimou U0 EKATOOTA
KQTA KOG TOU OKNVLKOU.

Anpoupyeital éva medio Keévou to omoio
€XEL pLa TeTpaywvn Aafn otnv mavw 6L
ywvia (Ewéva 22c).

Mpayte To Kelpevo.

To keipevo aANGleL ypappn otav ¢Tdoel
otnv 6g€La mAeupa tou neblou Kelpévou.
JUpete TNV TeTpaywvn Aafn ota Sl puexpL
TO KelpEVO va yiveL pLo ypapun.

Znpeiwon: Kavovtag SumAo KAk otnv

Ewkova 22a

i
N

A

Ewoéva 22b
Insertion point Round handle
"\\‘ //
Ewova 22c

asertion point

[

{ /

Square handle

7’




tetpaywvn Aafn aAAalel o€ KUKALKA KAl TO

niebio kelpévou pnopel va enektabel oe
KELUEVO LG YPOUNG.
11. Kavte KAK HoKpLd armd To KEEVO yLa val TO

QIOETUAELETE.

Emegepyaoia kelpévov

Mo va enetepyaocteite 1o Keipevo apol To SNULOUPYHOETE XPNOLLOTIOLOTE ToV EMBEWPNTN
SlotAtwv. Mmopeite va aANGEETE TIG LOLOTNTEG TOU KELUEVOU OTIWG TNV YPOUUATOCELPA, TO HéyeBOg
NG YPAUUOTOCELPAC TO XPWHA YEUIOUATOG, TNV OTOIXLON KAl TO TEPLOWPLO TWV YPAUUATWV.

XpNOLUOTIOLAOTE TO EPYAAELO KELWEVOU YLa
va eTUAEEETE TO Kelpevo (ewkova 22)

To keipevo mepkAeietal and to nedio

KELLEVOU

Xpnotlpomnolnote Tov emBewpnth
5loTATWV ylo va opioeTe TIg LSLOTNTEG TOU

KELUEVOU

(Ewkova 22d).
o Texttype

a.

Static: M'a Kkeipevo mou dev
Tporornoleital énwg ekeivo
TWV KOUUTILWY, ETIKETEG
dOpUAC KOt UIApag
mAonynong.

Dynamic: T'a mAnpodopleg
Ol OTIOLEC avavewvovTal
OTWG oL EL6NOELG OL OTtolEg
Byaivouv amd uia Baon
Sedopévwy.

Input: T keipevo To omolo
ELOAYETAL QIO TOV ETLOKETTN
TOU site OTWG MPOCWTKEG
TANpodopieC oL omoieg
oUAAEyovTal amnod uia Gpopua.

o Instance Name (Lovo yia dynamic kait
input text): OpileL €va dvopa yla To
OTLYMLOTUTIO KELUEVOU. AUTO gival
dlaitepa xpriotpo otav Bélete va
e\éy€ete TO Kelpevo péoa amo tnv
Action Script.

o Position and Size

a.

X, Y: EAéyxouv tnv B£0n tou
nieblou KelEVou og oxéon
€ TO OKNVLKO. OL TIEG 0,0
opifouv TNV MAvw aplotepn
YWVia TOU GKNVIKOU.

W, t: EAEyxouv TO KOG Kall
to U og Tou nediou
KELUEVOU.
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o Character
a. Family: OpieLtnv
YPOLLOTOOELPA TOU
KELUEVOU. 2€ éva mebio
KELWEVOU HItopoU e va
0pLOOULE TIEPLOCOTEPEG ATIO
LA YPOLLLOTOCELPEG.
b. Size: OpileL To UYoOC TOU
KELUEVOU.
c. Color: OpiteL to xpwpa
YEUIONATOG TOU KELUEVOU.
o  Character positioning

a. Superscript: ©@€teL TOUC
XOPOKTHPEC TOU KELUEVOU
navw arnd tnv ook
ypoppn.

b. Subscript: Oétel Toug
XOPOKTHPEG TOU KELUEVOU
KATw amno tnv Baotkn
ypapun

o Anti-alias: NpocBadatpel tnv
dLotnTa anti-alias oe éva keipevo.
H buotnta anti-alias opileL tnv
eoudAuvon Twv AKPWVY TOU KELUEVOU
£T0L WOTE va Yivetal meplocotepo
£UAVAYVWOTO.

a. Device fonts: Emutpémnel oto
dnuoaoteupévo Flash
£yypado va emAEEEL pLa
YPOUUATOOELPA ATtO TO
oUOTN LA TIOU €XEL OTOV
UTIOAOYLOTH TOU O
ETILOKETTNG KOL TO OTolo
talpLalel kaAllutepa otV
YPOUUATOOELPA TTOU
XPNOLUOTOLoaTE OTNY
oxedlaon tou eyypadou oag.

b. Bitmap text: XpfoLuo yla thv
poBoAn HikpoU os péyebog
Kelpévou. Ta bitmap fonts
Sev meplEXoLV TO
TeplypaLa TOU KELLEVOU
Slatnpwvtog £toL To Péyebog
TOU QPXELOU OTO PLKPOTEPO
Sduvatov. Ta bitmap fonts
6ev elval mote anti-aliased.

c. Anti-alias for Animation:
KataAAnAo yla keipevo os
Kivnon.

d. Anti-alias for Readability:
KataAAnAo yla Kelpevo to
ormolo sivat poévo yua
avayvwon.

e. Custom Anti-alias: ETutpémnet
TOV £Aey)X0 TOU TIAXOUG KOl
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> POSITION AND SIZE
X: 640 Y: 17}
= W: 104.2 H: 17.6
w7 CHARACTER
Family: | Times New Romar Iv'
Style: |Bold L:[
Size: 12.0pt Latter spacing: 0.9
color: [ & Auto ke
Anti-alias: | Anti-alias for animation | v |
Aol 7T
> PARAGRAPH
Format: @xinil§|
Spacing: 2B 0.0 px ]| 20pt
Margins: #B 00px B+ 0.0px
Behavior: | Mululine -

Orientation: 29 |+

U OPTIONS
[» FILTERS



(o]

™G ofuTNTaGg TWV KOPUDWV
TOU KELUEVOU eAEyXOVTOC UE
TOV TPOTO aUTOV To D€ anti-
alias Tou Kelpévou.
Selectable (ubvo yla dynamic kot
input kelpevo): EmLtpémel tnv emloyn
Kal avtypadr Tou KeLévou.
Render Text as HTML: Awatnpet tnv
popdomnoinon Tou EUMAOUTIONEVOU
Kelpevou, cupnepllappavopévou ta
HTML tags ta omoia cuvdéovtal pe
NV popdomnoinon autiv.
Show Border Around Text: ETutpénel
v epudavion meplypappatog yupo
a6 to nedio Keluévou.
Character Embedding (uovo yia input
kal dynamic keipevo): Opilel oUvoha
XOPOKTHPWV Ta omoia Ba
oupmnepiAndOolv oto SnUocLEVEVO
€yypado. Me tnv puBon autrv
au&avetal to péyebog tou apyelou.
Paragraph

a. Alignment: OpileL oto
Kelpevo 6814, aplotepn,
KEVTPO I AR PNG oTolixLon.

b. Line Spacing: EAéyxeL TV
anéotacn PETady Twv
YPOUUATWY o€ éva medio
KELUEVOU.

c. Behavior: OpiteL eav T0o
Kelpevo Ba elval pag n
TIEPLOCOTEPWYV YPOUHUWV.

d. Orientation of text: EA€yxeL
NV 0pLOVTLA R KOTAKOPUDN
B€on Tou KELUEVOU.

Options

a. URL link: Tuvbéel oto
Kelpevo pa StevBuvon oto
internet.

b. Target: ENéyxeL edv n URL
6levBuvon avolyel og véo
napabupo 1| oe
OUYKEKPLUEVO TTAQOLO pEoa
otnv oeAida.

c. Variable: Juvdéel pla
petaBAnt oto medio
KELUEVOU yLa XPrON UE TNV
Action Script.
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AvTiypa@n Kot eMKOAAN 01 KELUEVOL

1. Zekwnote to Flash kat avoifte éva véo éyypado.

2. Avoifte éva £yypado amo pia AN epappoyr To omoio TEPLEXEL TO KElUEVO TO omoio BEAeTe va
avTlypayete.

3. Em\ére to Keipevo kat aviypate to oto clipboard.
4. %10 Flash, SnuloupynoTte 0TO GKNVLKO €va TIAALOLO KELLEVOU.
5. Em\étte Edit > Paste Special.

Avolyel To mAaiolo dtadoyou Paste Special
(Ewkova 22e).

6. Emu\é€te Text (ASCII).
7. Natote OK.

To Kkeipevo £xeL emikoAANnOel péoa oto medio kelpévou mou dnploupynoarte. Twpa Propeite va
OAAGEETE TIG LOLOTNTEG TOU KELEVOU XPNOLLOTIOLWVTAG TOV EMOEWPNTH LOLOTHTWV.

Ewkéva 22e To mAaiclo Staldyou Paste Special

Bodyer 1o nepunsiyesn Tou Mponaiaos 016 &7 poed

ﬁ DT ag 3 petaw

Xpnolpomolwvtag Tov EéAeyxo opBoypapiag

To Flash €xelL evowpatwpévo €leyxo opBoypadiag tov onoiov pnopeite va

XPNOLLOTIOLNOETE.
1. EmMé€te Text>Check Spelling. Ewova 22f

Avolyel To mhaiolo Stahéyou Check creaspeing T e
Spelling (Ewova 22f). "‘y,;_p‘_fg{v_@gw: , i

Endoguéen asieeo] | &4 toPersondl |

2. Xpnowuormoleiote To mAaiolo Staloyou [ e |

Check Spelling e Tov (610 TPOMO OMWG [ gpeen |

o€ aA\eg edappoyec. Na mapadelyua, [ Quge

KAvte KALK oto koupuri Change yla va LscChoope b,

oAAGgete pla avopBoypadn AEEN. et )

senp, | [ Dee |

19



2.8. Line Tool

Line tool (eikova 23): 3xedlalel euBeieg ypOUUEG.

1. Kdavoupe kAlk oTo epyaleio TNG YPOLLUNAG. Ewova 23

2. Kavoupe KAk yla va oplooupe To 1o onuelo, c€pvoupe 1
000 eMBUUOUUE KOl OLPHVOULE TO TIANKTPO TOU
TIOVTLKLOU YyLa val oXeSLaoTel N ypouun.

3. MmopoUue va eTAEEOUUE TNV VPO LE TO EpyaAeio
Selection kal otnv cuvéxela amno tov EMBswpnTH 2
L6LoTATWV Vol 0AAAEOUHE TIG LOLOTNTEG TNG OTIWG TO
XPWUO TNC. Mot VoL TNV OIMOETUAEEOULE KAVOULLE KALK
OTOUSNATIOTE OTOV KaPA.

4. Av dp€poupe Tov SeIKTN TOU TTOVTLKLOU KOVTA:

a. g pa akpn, 8o epdaviotel éva avamnodo L
SimAa aro tov SelkTn TOU MOVTIKLIoU. TOTE
UTTOPOULE VO KAVOULLE KALK KOL VO GUPOULE TNV
AKpn TG YPAUUNG LETABAANOVTAG TNV. 4

b. Omoudnmnote aAlov, sudavileTal pLo KAUUAn
ToV SeiKTn TOU TOVTIKLOU. TOTE UMTOPOULE VOl
KAVOULE KALK KOL VO GUPOULLE TO WO TNG
VPOUHUHUAG KAUTIUAWVOVTAC TNV. 5

5. Itnv mponyoUUEevn MePIMTwWaon, €AV MATAOW TO TTANKTPO
control Tou MAnktpoAoyiou katl cUpw, SNULOUPYW KL
OLKULF) OTO GWHOL TNG YPOUAG.

[/

Tooo mplv TNV oxediaon 000 Kol HETA HECW TOU properties inspector, pmopw va GANGEW:

e To yxpwpa (strokecolor)

e To mayog (stroke) kat to otuA (style)tou xpwpatog

o Tnv kAipoka scaletng ypappng otav n tawia avanapdyetat otov Flash Player.

e  Tnv opaAOTNTA TWV AKUWV TNG Ypauung (Cap)

e  Tnvopalotnta twv cuvdéoewy Suo ypappwy Join kal Miter. Otav emihé€oupe
miteroto Join, unopoUue va oplooupe TNV 0EUTNTA TNG AKUNG oTnv WSlotnTa Miter.
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2.9. Rectangle Tool

AnpLloupyel TETpAYWVA OXALOTA UE YEUIOUATA KAl YPAUUES, LOVO Yeulopata i Hovo
VPOUUEG. Me emAeypEvVo Eva OoxXUO KoL LECW TOU properties inspector pmopol e va
petapfaloupe

o 11 dlootaoelg (width&height), pe 1 xwpic kAelbwpéveg Tic avaloyieg
e v beon (x,y),

o Ta xpwpato yeUlopaTog Kot TEPLYPAUUATOC

e T0 mayog (strokeheight) kat Tov TUMO TOU TIEPLYPAUpATOC (Style),

e TPOTO EPUAVLONG TWV YWVIWV OTOo oxnua (cap&join).

Xpwpa kat Stapavela

‘Eval TETpAYWVO UMOPOUE VA TO Ewova 24a
oxeblalooupue 1 7
1. Me mepiypappa Kot YEULoUA . T
2. Me nepiypoppo povo )
3. Me véutoua' HOVO ’ 2 j ::gsz:;g
4. Me nooooto dladavelag
Edv og éva TETpAYywVo amoucLalel To 3 .
neplypappa 1) To YEMLOHA SV UMOPOUUE VO
TO MPOCBLCOUUE HECW TNG TTAALTAG
L8LotNTwv. MpEMeL va XpnOLLOTIOLCOUE TO 4
ink bottler) to paint bucket avtictowya.

TeTpaywva Kot KAUTUAEG

Otav emilé€oupe To epyaleio rectanglekal mpLv oxeSLACOULE TO OXNUQ, UTTOPOUUE va
oplooUE TNV UTAPEN 1 LN KOUTMUAWV OTLS YWVIEG TOU TETpaywvou (glkova 24B)otny
katnyopia Rectangle Optionsctov properties inspector. Ot KaumUAEG QUTEG UTopoUV va
elvat (6leg ) OxL avahoya pe To av elval evepyomolnuévo to elkovidio Lock corner radius.

Ewova 24B

TpomoToinon oxpatog

Me to epyaleio selection pmopoUpe va TPOTOTIOLCOULE TO TETPAYWVO O €va AAAO oxrua.
AuTO yivetal 1600 pe o epyaleio selection 6oo kal pe to epyaleio sub selection.
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2.10. Oval tool

Anptoupyel kKOUKAoUG, OBAA, NULKUKALQ, LE 1} XWPLG E00XN, YEULOMOTO UE YPAUUESG, LOVO
veulopata r povo ypaupés. Me kpatnuévo to nmAnktpo Shift prmopw va ¢ptiafw évav télelo
KUKAO.

Me emileyuévo €vav KUKAO KoL HEow Tou properties inspector pmopoUpe va HeTofAloupe

e 11 Slootaoelg (width & height), e ) xwpig kKAelbwPEVEG TIG avaloyieg
e v beon (x,y),

o Ta xpwHaTto yeUlOUATOC Ko TEPLYPAUUATOC

e 1O Tayoc (stroke height) kat tov tuMo TOU MEPLYPAUATOC (Style),

e  TPOTO gUPAVLONG TWV YWVIWV oto oxNua (cap & join).

Xpwpa kot Stapavela

‘Evav kKUkAo pmopoupe va tov oxedialooupe  Ewkova 25a

1. Me neplypappol Kot yEULOHO 1 4
2. Me nepiypoppo povo T
3. Me yéulopa povo )
4 M 05 , 2 Amrouagia
. € T0000TO dladavelag . ——
Edv og évav KUKAO amouctldlel To
NEPiYPAPHA 1] TO YEHULOHA SEV PITOPOUHE va. 3 .
TO POOBECOUE PECW TNG TMAALTOC
SlotAtwy. NPEMEL va XpNOLLLOTIOLCOU LE TO
inkbottle | to paint bucket avtictowya. 4
Object drawing kat emKAAV YT AVTIKELLEV WV
Me evepyomolnpévn tnv eruhoyn object Ewova 253
drawing otnv naA£ta tools (1) k&Oe ypadikod
ng ot ! (1) e vp ¢ 1
oxeblaletal we avefApTnTo AVIIKEipEVO. Mg
ToV TPOTO QUTOV, SU0 AVTIKELEVA UTTopolV
VO ETUKAAUTITOVTOL XWPLG va «KOPBEL» TO éval

TO GAAO.
Ye avtiBetn nepintwon (2), ta oxnuata sivat

amAd ypadkd Ta onoia kOBovtal othv 2 0
ovdAoyn mepintwon.
Inueiwon: H ddtnta autr LoXVUEL KaL yLa To

rectangle.
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HuwkVvkAla kot donuts

‘Otav kavoupue kALk oto epyaleio Oval pmopol e va Ewdva 25y
0pLoOUE TIG aKOAOUBEG LBLOTNTEG oTNV Katnyopia Oval . O Close path
Options otov Properties Inspector: Start \L

e Tnvywvia évapéng tou KUkAou, startangle,

e Tnvywvia teppatiopol Tou KUkAou, endangle,

e Tnv aktiva Tou ecwteplkol KUKAOU, inner angl
radius, p.€ TNV omolia pmopoupe va ptidéoups
éva donut

e Closepath, 6tav sival evepyonotnpévo Gptiayvet
YEULOMQ otov KUKAo. Otav ivatl
OUTIEVEPYOTIOLNEVO PTLAXVEL LOVO T KUKALKAL
TEPLYPAUOTA T OTIOLA Elval EEXWPLOTEG
KOUTTUAEC.
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2.11. Rectangle Primitive Tool

Anploupyel TeETpaywva PE N XWPLE KAUTTUAEG aKUEG. Ol KAUMUAEG UTTOpEL va TTpoG Ta HEoa
npog ta £€w. H dladopég Tou pe To Rectanglesival:

e Ol KOUMUAWGT TWV YWVLWV UTOPEL va TpomomnolnBel Kal peta Thv oXedLaor) Tou.

e Otav 6Uo avtikeipeva primitives kaAUPouv To €va To AAAo, Sev «KOBovTaL) LETALY
TOUG.

e Agv UMopoUE Va TPOTIOTOLHCOULE TO OXNA LLE TNV Xprion Tou epyaleiou selection

[8t6TnTES

Me emnheyuévo €va Rectangle primitive kal péow tou properties inspector pnmopoUpe va
petaBdloupe

o TG Slootdoelg (width&height) pe R xwplc KAELWOWHEVES TIG AVOAOYIES

e v Béon (x,y),

e Ta XpWHATA YEUIOUATOG KOl TIEPLYPOULLOTOG

e 1o mayog (strokeheight) kat tov TUMo TOUL MEPLYpAppATOC (Style),

e TPOMO £PUAVIONE TWV YWVLWYV OTO oXNua (cap&join).

e KapmuAwon ywviwv (lkova 26):
Itov properties inspector kat otnv katnyopia Rectangle options pmopoupe va
UETOBAAOUE TNV OKTIVA TWV YWVLWV N omola prmopet va eivat Bgtikn (1) A apvntikn
(3). Eav n emhoyn Lock corner radius control (2) ival evepyomotnpévn, Tote OAEG oL
ywvieg €xouv (SLa TLun.

Ewova 26
1 2 3
r 3
b _d
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2.12. Oval Primitive Tool

Anptoupyel kOKAoug, OBAA, NULKUKALQ, LE 1} XWPLG E00OXN, YEULOMATO UE YPAUUESG, LOVO
veulopata f povo ypaupés. Me kpatnuévo to nmAnktpo Shift pmopw va ¢tafw évav téAelo

KUKAO.

H Stadopég tou pe to Oval eivat:

'OAeg oL LBLOTNTEC TOU UTTOPOUV VA TPOTOTIONB0oUV KoL LETA TNV OXESLOOH TOU.
Otav U0 avtikeipeva primitives kaAbPouv to €va to dANo, Sev «kOBovtaly PeTAL
TouC.

Aev UTTOPOULIE VO TPOTIOTIOL|GOULIE TO OXN A LE TNV XpHon Tou epyoleiou selection

[0t TES

Me el eypévo €va Oval primitive kal pécw tou properties inspector pmopoU e va

UETOPBANOUE:

Ti¢ Slaotdoelg (width & height) pe ) xwpic kAeldwpéveg Ti¢ avaloyieg
v Béon (x, ),
To XpWHATA YEUIOUATOC KOl TLEPLYPALUOTOG
TO ayoc (stroke height) kat tov TUmo Tou Meplypappatog (style),
TPOTIO EUPAVIONG TWV YwVLWV 0To oxnua (cap & join).
Jtnv katnyopiaOval Options otov Properties Inspector (ewkova 27) pumopoU e vo
peTaBaAloupe ta akoAouba:
o Tnvywvia évapéng tou KUkAou, start angle,
o Tnvywvia teppatiopol Tou kKUKAou, end angle,
o Tnv aktiva Tou ecwteplkov KUKAOU, inner radius, e TV onoia PmopoUpe
va dptiafoupe éva donut
o Closepath, 6tav eival evepyomotnuévo ptiayvel yEULopa otov KUkAo. Otav
elval anevepyomolnUéVo GTLAXVEL LOVO TA KUKALKA TIEPLYPA AT Ta OTtola
elvat EexwploTeg KAUTUAEG.

Ewova 27

Inner Start [ Close path

radjus angle
T

End
ngle

=/
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2.13. Polystar Tool

Me autd to epyaleio Snpoupyolpe TOAUYWVLKA oxrpata o€ popdn aoteplol 1
ToAUywvou. MTopoU e va opiooupe To TARBOG TWV YWVLWV f TTAEUPWV TTOU £XOUV OUTA T
oxnuara.

TIg LOLOTNTEG UTEC UIMOPOUE VAL TIG OpLOOUE OVO TIPLV TO OXESLACOUE. ITNV TTAALTA
properties inspector kal otnv katnyopia Tools settings kavoupe KALK 0TO KouuTii options To
orolo avoliyel to mapaBupo Tools Settings oto omoio oplloupe TIC TAPATIAVW LOLOTNTEG.

AM\EG LOLOTNTEG TIG OTOleG UmopoUUE vo oplooupe péow Tou Properties Inspector kat
Katormiv oxediaong ivat:

e TIc dlootaoelg (width & height) pe ) xwplig kKAelbwpEveg TG avaloyieg
e v beon (x,y),

o Ta XpWHOTO YEUIOUATOC KOl TLEPLYPAUUATOC

e 1O Tayoc (stroke height) kat tov tuMo TOU MEPLYPApMOTOC (Style),

e  TPOTO EUPAVLONG TWV YWVIWV oTo oxNua (cap & join).

MrmopoUE Vo TPOTIOMOLI|COULE TO oXNa Lie To epyaleio selection epocov bev £xoupe
dtiael To oxnua Le evepyomolnpévn TN emthoyr) object drawing tng malétag epyoaieiwv.

Jtnv ewkova 28 BAEmou e SU0 oxNUATA Eva AOTEPL KL £vVa TTOAUYWVO

Ewova 28
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2.14. Pencil Tool

Anpoupyel oxnUata YPAUUWY. YIIAPXOUV YPOULES TPLWV TUTIWV:

1. euBeieg (straighten), Ewkova 29
2. opaheg (smooth) i \[_—Z](—Pencil Tool
3. ueAaviou (ink). T
, o t L
Ot TumoL ypappwy opllovtal otnv | Nz
Tieploxn options (4) tng naA£tag
£pYOAELWV OTAV KAVOUE KALK OTO =
, . 2
epyaheio pencil. | \ J'

‘Exovtog emiAé€el smooth, pmopolpe va

, , , 3 f
oplooue To T0000TO opaAdTNTAG OTNV /_ \\ )
katnyopia Smoothing tng maAétag
properties mpLv tov oXeSL0.010 TNG

YPQHUAG.

4 S‘ = Straighten
IS Smooth

% Ink

Tooo mplv TNV oxedilaon 000 Kol UETA HECW TOU properties inspector, pmopoue va
oANGEOUHE:

e To xpwpa (stroke color)

e To mayog (stroke) kat to otul (style)tou xpwuoatog

e Tnv kAlpoka TG ypappng étav n tawvia avamnapdyetot otov FlashPlayer.

e Tnv opaAOTNTA TWV AKUWV TNG Ypauung (Cap)

e Tnv opalotnta twv cuvdéoewyv Suo ypappwy Join kal Miter. Otav emhé€oupe
miter oto Join, unmopouUpe va opicou e TNV o£UTNTA TNG OKUNG otV WBLotnTa Miter.

YTnv meployn options tng MOAETAC EpYAAEiwV UMOPOULE VA EVEPYOTIOLCOUE TNV €TAOYN
object drawing pe tnv omoia oxeb1aloupe YPAUUEG, KABE LLO WG EEXWPLOTO AVTIKEIUEVO, LE
amoTEAEOHA OTAV OL YPAUUEG Eival AAANAETUKAAUTITOMEVEG VA NV TLAPAPOPdWVEL N pia TNV
GAAN.

MTopoU e VO TPOTIOTIOLGOUE L YPOLUUH LE TO epyaleio selection edbdoov dev £xoupe
dTageL To oxpo pe evepyomotnpévn tnv emloyn object drawing tng maA£tag epyadeiwv.
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2.15. Brush Tool

Anpoupyel oxnuata PLOvVo YEULOUOTOG.

Tooo mplv TNV oxediaon 000 Kol HETA LECW TOU properties inspector, pumopoue va
oAAagoupe:

e To yxpwpa (fill color)

e To mayog (stroke) kat to otuA (style)tou xpwpatog

e  Tnv kAlpoka Tou yepiopatog étav n tawvia avamnopdystat otov FlashPlayer.

e  Tnv opoAOTNTA TWV OKUWV TNE Ypauung (Cap)

e Tnv opaAdtnta twv ouvbéoswv duo ypappwy Join kot Miter. Otav emihééoupe
miter oto Join, unmopouUpe va opicou e tnv oUTNTA TNG OKUNAG oTNV WBLoTtnTa Miter.

TNV Katnyopia options tng MaA£tag epyaleiwv EXOUE TIG aKOAOUBEC eMIAOYEC

1. Object drawing. IxeSialouvpe Ewodva 30

veulopara, kaBe £va wg
£eXWPLOTO AVTLKEIPEVO, UE
QTMOTEAEGHA OTAV ETMLKOAAU Y OUV 1
TO £val TO GAAO va UnV Yivetal
peTaL TOUC MapaOpdwon.
2. Lock Fill. 28—

NeltoupyeipedlaBabuioelc. = &3 Paint Normal
Otav eival emiheypévo, @ raint Fills

UropoUpE va oxeSLACOUUE
ULKPQA KOUATLO TOL OTtolOL £XOUV
£va Koo xpwpa Stapaduiong
Selyvovtag £TOL Lol CUVEXELD TO
£va e To dAho. LS

“E <—— Brush Tool

o]

{) Paint Behind
@ Paint Selection
(3 Paint Inside

3. Brush Mode. OpilelL tov TpomMO
YEULOMOTOG.

4. Brush Size. Opilel to maxog tnN¢
Bouptoac.
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2.16. Paint Bucket Tool

MpooBEtel yéULopa og Eva KAELOTO QVTIKELPEVO | AAANALEL TO XPWHO YEUIOMATOC. ATIO TNV
TaA€Ta properties inspector eMAEYOU E £va XPWHA KOL OTNV CUVEXELA KAVOUE KALK HEoQl
OTO OXA O I OE UTLAPXOV YEULOUAL.

Kavoupe kALK oto elkovidilo paint bucket (1) kat otnv Ewova 35

OUVEXELX KAVOUE KALK HEoa O €va KAELOTO oxnua (2) R 1 @

o€ UTIAp)oV XpwHa (3).

2Tnv naA£ta epyoleiwv uTtapyouy ol €€N¢ LOLOTNTEG: 2 ( )
e Gap Size (4). l'epilel oxnpota to omoia £Xouv Kevo \ )

oTo meplypappa Toug. To Kevo pmopel va €xeL éva

ULKPO €UPOC O€ AVOLYUAL. 3
e Lock fill. Asttoupyel pe StaBabuioeis. Otav gival

eTAeYUEVO, YeUiloupe SLadoyLka KAELOTA

OXNUOTA TO OTtola £XOUV VA KOLVO XPWULOL

SeiyvovTtag £T0L L0l CUVEXELO TO £Val JIE TO GAAO. 4 Gap Size

L] O Don't Close Gaps
() close Small Gaps

() close Medium Gaps

() Close Large Gaps
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2.17. Ink Bottle Tool

AMGeL TO XpwHa A TO PEYEOBOC LG YPAUUNG KAL TIPOCOETEL Mepilypapia O EVol OXHHA.

Kdvoupe kA oto ewkovidio ink bottle (1) tng | [1 BT
ntalétag epyaleiwv. Itov properties L
inspector punopoU e va oploOULE:
e To xpwpa (stroke color)
e To mayog (stroke) 2
e  Tnv KAlpaka Tng ypapupng scale otav
n tawia avamnapdyetot otov Flash
Player.
e TNV opaAOGTNTA TWV AKUWV TNG
ypouung (Cap) 3
e Tnvopalotnta twv cuvdéoewv duo
ypouuwv Join kat Miter. Otav
emAé€ou e miter oto Join,

UropoUpE va oplooupe Ty ofuTnTa
NG aKUAG otnv Botnta Miter.

2TNV CUVEXELQ UMTOPOUE VaL:
2. KAvoUupE KALK o€ €va
VéuLopaedappolovtog meplypapo
O€ aUTO,
3. VO KAVOUE KALK O€ EVal YEULOUA
ME uTapxov Teplypappa
edappolovrag T aAAAYEC TTOU
oploape otov properties inspector.
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2.18. Eye Dropper Tool

Astypotilel éva xpwuo armd TV MOAETA XPWHATWY ) oo onoloSAMoTe onueio Thg 08ovnc.

1. Kavoupe kAik oto epyaleio Eye Dropper, Ewkova 37

2. NopatnpoUlye, yla mapaselypa, TwE TO XpWHa 1 &
YEULOPATOC lval PTTAE.

3. Kavoupe kALK o€ £va GAAO XpWHQ, YLa TTOpASELY A TOV
TPACLVO KUKAO OTIOU Kall 0 S£(KTNG TOU MOVTIKLOU
METATPEMETAL O KOUPBASAKL. 2TNV CUVEXELA KAVOU LLE
KALK o€ YEULOoPO AAAOU X1 MOTOG.

2

A A

®

| B S
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2.19. Eraser Tool

Alaypadel TUAPOTA TNE EKOVAG.

1.

Kavoupe kAlk oto epyaleio Eraser.
Mo va StaypaPoupe, KAVOUUE KALK
KOL GEPVOUE OTNV emBUUNTA
nieploxn. Me S KAK oto
gpyaheio, Staypadoupe ta mavia
OTO OKNVLKO.

Eraser Mode: Mg tnv 810tnTa auTh
KaBopiloupe Ta avTIKEipEVA TTOU

Ba Staypadoupe:
e Eraser Normal: Alaypadel
TO AVTO.
e Erase Fills: Alaypadel Ta
veulopara.
e Erase Lines: Alaypdadetl
YPOHHEG.

e Erase Selected Fills:
Awaypdadel pévo 6oa
VeUlopoTa €Xoupe eTUAEEEL.

e Erase Inside: Alaypadel T0
E0WTEPLKO TWV
OVTLKELLEVWV.

Facet: Alaypadel oAOKANpeG
TLEPLOXEC YeUlopaTog N
TIEPLYPAUATOC aVAAOYOQ. LE TO TIOU
KAVOULE KALK.

Eraser Shape: Mepléxet Stadopa
OTPOYYUAQ N TETpAywva HEYEDN
TivéAou.

Ewova Eraser Tool

1

Z]

_ L] C Erase Normal

O Erase Fills

O Erase Lines

O Erase Inside
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2.20. Hand Tool

MeTakLVel To OKNVIKO yLo va TtpoBalel A a onpeia tou eyypadou. H Asttoupyia autr eivat
XpNoun otav Sev PAEMW OAO TO OKNVLKO.

Kavoupe kAlk oto epyaleio Hand, o 8&(KTnG TOU TOVTIKLOU PETATPEMETAL O XEPL, KAVOUE

KALK KATIOU OTOV KAUPBA KOl CEPVOULIE.

To gpyaleio Hand dev €xeL 1BLOTNTEG.

A
W
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2.21.Zoom Tool

EotiaZel meploodtepo (zoom in) i Aydtepo (zoom out) tnv 006vn. Ytdpxouv 2 eTUAOYEG

oTNV TIEPLOXN TNG TTOAETAG Epyaleiwy.

1. Kdvoupe KAk oto epyaleio zoom. 1 ‘ oy

2. Me 1o enlarge gotlaloupe EPLOCOTEPO. A VA EOTIACOUUE o
Alyotepo (zoom out), kpatriote To MARKTPO Alt. 2 -

3. Me to reduce eotlaloupe Ayotepo. MNa va l§|
£0TIACOUUETEPLOCOTEPO (ZzOOM in), KPOTHOTE TO TTANKTPO 3 2Q
Alt.

4. MTMOpPOUE VO XPNOLUOTIOL)OOUUE KOL TIG ETOLUEC ETUAOYEG 4 Moo%
™¢ aAayng pey€Buvong otnv pnapa ensfepyaociag.

Mrmopw va cUpw €va mapdBupo miAoyng SnNULOUPYWVTAG £TOL TO
Too0oTO PeyeBuvong mou BAw.

Avetaptnta amnod to epyaleio oxediaong, pnopol e va
XPNOLUOTIOLOOUE TOV CUVSUACHO TIANKTPWV

e Ctrl+’+'yia zoom in

e  Ctrl+’-’yia zoom out
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